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INTRODUCTION 

This is a collection of tools that will help you manage any photos you have submitted to Alamy, directly 

from within Adobe Lightroom. You're still perfectly free to use Alamy's online tools, or a mixture of the two, 

but hopefully this will remove a few steps and make things easier for you. 

I am assuming that you already have an Alamy account, and some photographs already on sale with 

them. If not, you should go and take a look at their “Contributors” section at 

http://www.alamy.com/contributors/default.asp . 

This manual won't try to explain how to use Lightroom, or how Alamy's submissions procedure works. 

It will, hopefully, give you enough information to be able to go ahead and start tracking your images in a 

new way. 

CONTACT AND SUPPORT 

You can get support or ask questions from the website: 

http://www.lightroom-plugins.com/contact.php 

LEGAL STUFF 

This plug-in is not specifically endorsed by either Adobe Inc.® or Alamy Ltd™. The use of the Alamy logo 

in the software is purely for clarity, and does not imply any affiliation between the author of the software 

and Alamy Images. 

WHAT'S INCLUDED 

NEW MODULES 

The most important features of the plugin are provided as Export modules for Lightroom, even though one 

of them technically isn't an export. In brief, they are: 

1. UPLOAD TO ALAMY 

This takes any images you have selected in Lightroom and up-

loads them to Alamy if they have not already been uploaded. 

2. FETCH ALAMY METADATA  

Allows you to get any metadata from Alamy, including their 

own special data, and tries to match it to the images in your 

Lightroom catalog. 

3. SET ALAMY METADATA 

Takes any metadata you have set locally, including Alamy's 

special data, and uploads it to their servers. 

 

http://www.alamy.com/contributors/default.asp
http://www.lightroom-plugins.com/contact.php
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NEW COMMANDS 

Several extra commands have been added to the  

“Library” menu in Lightroom: 

1. CLEAR ALAMY STATUS 

This removes the Status field, which is not 

normally editable, and optionally removes all 

Alamy metadata from any selected images. 

2. ALAMY EXPORT TO CSV 

Creates a CSV file containing all Alamy metadata 

for any selected images. 

3. UPDATE ALAMY SYNC STATUS 

Scans the entire database and checks to see which images have had their metadata changed locally 

since they were last Set or Fetched from Alamy. 

New in March 2012: 

1. EXPANDED “EXPORT TO CSV” 

This option can now create three different formats of CSV file containing different information. 

2. ALAMY IMPORT FROM CSV 

Read a CSV file and replace the caption and keywords on existing photos. 

3. REASSIGN KEYWORDS 

Recreate Alamy’s “Essential”, “Main” and “Comprehensive” keyword fields based on the Lightroom 

keyword hierarchy. 

4. PREVIEW KEYWORDS 

Show a box containing the keywords that would be set with the previous command, or when using 

the Set Metadata exporter when no keywords are set. 

5. FIND DUPLICATE ALAMYREFS 

Identify photos where more than one has had the same AlamyRef assigned. Since this is the main 

item that is used when fetching and setting metadata, it is important that only the correct photo 

has this value assigned. 

NEW SMART COLLECTIONS 
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To make it easier to find your images, there are several new Smart Collections provided. Smart 

Collections automatically find images in your catalog without having to be manually refreshed when 

something changes. 

The Smart Collections are not created automatically by the plugin, so that you are free to rename or 

remove them if you wish. To create them, simply import them from disk – see the instructions on page 6. 

 ALL UPLOADED IMAGES 

Shows all images which Alamy have stored, which can be matched in Lightroom. 

 DUPLICATE 'YOUR REFERENCE' 

All images which Alamy returns, which have more than one possible match in Lightroom. 

 HAS SOLD 

All submitted images which have a non-zero sales total. 

 MORE INFORMATION REQUIRED 

Images which are on sale but for which Alamy 

needs more information. 

 NEEDS METADATA DOWNLOADED 

Images which have an Alamy Reference but are 

missing other Alamy-specific metadata. 

 NEEDS SYNC 

Lists images which have had metadata changed in 

Lightroom since the last metadata fetch or set. 

 NO CAPTION 

Images which have an Alamy Reference but have no IPTC Caption set. 

 NO ESSENTIAL KEYWORDS 

Images which have an Alamy Reference but have no Alamy Essential Keywords set. 

 NO MAIN KEYWORDS 

Images which have an Alamy Reference but have no Alamy Main Keywords set. 

 ON SALE 

All images which Alamy report are on sale. 
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 READY 

All images which Alamy report are ready for sale, but which are making their way through Alamy's sys-

tems. 

 NOT READY 

All images which have been accepted by Alamy but are awaiting essential metadata before they can go 

on sale. 

 LICENSED 

Images which have a licence type of 'licensed'. 

 RIGHTS-PROTECTED 

Images which have a licence type of 'Rights-Protected'. 

 ROYALTY-FREE 

Images which have a licence type of 'Royalty-Free'. 

 ALL SUBMITTED 

Images which have been uploaded using Lightroom but which are still awaiting QC or rejected. 

 COPIES OF SUBMITTED 

If you have chosen to store the actual JPEG copies uploaded to Alamy, they are listed here. 

 ORIGINALS SUBMITTED 

The original images that were used to create JPEGs uploaded to Alamy, but which do not yet have an 

Alamy reference number. 

 

INSTALLATION 

This plug-in adds some new fields to your Lightroom database. These are used to store the Alamy-

specific metadata such as licensing, model releases etc. 

Before you install this, you should make sure you have a backup of your Lightroom catalog. If you do 

not already have automatic backups enabled, you can perform a single backup by going to “Edit→Catalog 

Settings...” and changing the “Back up catalog” list to “Next time Lightroom starts only” for 

Lightroom 2 or “When Lightroom next exits” for Lightroom 3 or 4, and restarting Lightroom. 

WINDOWS 
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AUTOMATIC INSTALLATION 

The easiest way to install on Windows is to use the MSI installer. Simply double-click and run through 

the prompts that appear. 

MANUAL INSTALLATION 

If you prefer to install manually, download the ZIP file instead of the MSI. When it has downloaded, 

unzip it and do one of the two following things: 

1) Copy the folder called “AlamyUpload.lrplugin” into Lightroom's “Modules” folder. This can 

be found at: 

Windows XP:  %APPDATA%\Adobe\Lightroom\Modules\ 

Vista/Windows 7:  %APPDATA%\Roaming\Adobe\Lightroom\Modules\ 

2) Use the Plugin Manager to add the plugin, by clicking on the “Add” button and selecting the 

“AlamyUpload.lrplugin” folder. This is the same procedure described in more detail for the 

Mac, below. 

MACOS 

Download the ZIP and extract it to your desktop. You should see a folder called “AlamyLoader”, 

containing the plug-in and folders called “Smart Collections LR2” and “Smart Collections 

LR3”. Put the plugin anywhere on your disk that you choose, and use Lightroom’s Plugin Manager to load 

it, by clicking the “Add” button at the bottom left of the dialog. 

Check that a plug-in called “Upload to 

Alamy” is shown as “Installed and running”. 
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SETTING UP LIGHTROOM 

INSTALL THE SMART COLLECTIONS 

While you don't have to install these for the plug-in to work, they do make finding your Alamy images 

easier. If you are using Lightroom 3 or newer, they will be installed for you when you start Lightroom after 

having installed the plugin. For Lightroom 2 this is not possible, so you will need to install them by hand. 

Manual installation is fairly straightforward: 

1. Create a new Collection Set by clicking on the plus symbol to the right of the “Collections” header. 

2. Right-click on the new “Alamy” Collection Set and select “Import Smart Collection Settings”. 

3. Select the first of the Smart Collection files. These are in a folder called “Smart Collections 

LR2”. If you installed using the ZIP file, they will be wherever you extracted the ZIP to. If you installed with 

the Windows MSI file, they will be in “C:\Program Files\Jim Keir\Lightroom Alamy Plug-

in” or “C:\Program Files (x86)\Jim Keir\Lightroom Alamy Plug-in” if you have a 64-bit 

version of Windows. 

4. Repeat this for each of the Smart Collections provided. 

ENTER YOUR LICENCE KEY 

If you have bought the plug-in, you should receive a licence key in an email. Without this, the plug-in 

will process only three images at a time. To enter the licence key, simply copy and paste it from the email 

to the box in the Connection Settings dialog that is at the top of the Plugin Manager. 

If you lose your license key, you can retrieve it at any time from the Support Center at 

http://www.lightroom-plugins.com/support.php . You will have had an account created automatically; if 

you have never used it before, you can use the “Forgot Password” button to receive an email containing 

the account password. The account name will be the email address that you used to buy the license. 

 

http://www.lightroom-plugins.com/support.php
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QUICK-START 

This assumes you already have some images on sale with Alamy, and that they are stored in Lightroom. 

The key to matching the images is the original filename, which Alamy takes as “Your Reference”. 

The following section simply tells you what to do, not why you’re doing it, so please take the time to 

read the more detailed sections of the manual later. 

These are the basic steps: 

- UPLOAD SOME PHOTOS TO ALAMY 

This can be done using the plugin, or separately using Alamy’s uploader. The plugin will work with 

both new photos and ones you have had with Alamy for some time. 

- RUN THE FETCH ALAMY METADATA EXPORTER 

This will contact Alamy and ask for information about any photos you have with them. This 

information will include the “Alamy Reference” and “Your Reference” values – these two are key to 

the rest of the process. 

- UPDATE INFORMATION IN LIGHTROOM FOR MANY PHOTOS AT ONCE 

Use Lightroom’s tools to help set your keywords, captions and any other relevant information. Or, 

use Alamy’s online tools to do the same, whichever you prefer. 

- USE THE PLUGIN’S EXPORTERS TO UPDATE THE CHANGED DATA 

The “Set Metadata” will send some or all of your changes to Alamy, and the “Fetch Metadata” will 

bring changes at Alamy back to Lightroom. 

To get started, select any image at all and use the “File→Export...” menu. At the top of the Export 

dialog, you should be able to choose “Fetch Alamy Metadata” from the list of exporters by clicking on 

the large heading which (depending on the version of Lightroom) will probably say “Files on Disk” or 

“Hard Disk”. 

Open the Plugin Manager and select the “Upload to Alamy” plugin. Enter your Alamy username and 

password and, if you have one, a licence key. Click 'Done' in the Plugin Manager, and then on 'Log In', and 

within a few seconds the 'Alamy UserID' and 'Session ID' fields should change. If there is a problem with 

logging in to Alamy, you will be told. 

In the 'Download Settings' section of the export dialog, tick 'Show log on completion ' and un-tick 

the other two options. Finally, select 'Fetch data for all images' before clicking on 'Export'. 
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Because this is the first time you have contacted Alamy using the plugin, you will see a dialog saying 

“Your pseudonyms have changed”. To pass this, you must restart Lightroom; this is so that it can update an 

internal list containing your Alamy pseudonyms. 

Once you have restarted, select the “File→Export...” menu and click 'Export' again. The normal 

Lightroom Export status bar should start to work through all your images – that is, the ones stored at 

Alamy, not the ones in your Lightroom catalog – and try to match them. 

Once it has completed, you will be shown a webpage showing whether or not each image could be 

matched. Any that couldn't be matched will be shown in red along with the reason. Any metadata that was 

changed as part of the download will also be reported on this page. 

These logs are stored in your Documents folder, in a sub-folder called “Alamy Logs”. 

 



Lightroom Alamy Picture Manager - Manual 

 9  

http://www.lightroom-plugins.com 

The matching works like this: 

 If one image can be found in Lightroom where the filename matches “Your Reference” at Alamy, it 

is matched. 

 If more than one image is found, and one already has a matching “Image Reference”, that one is 

matched. 

 Otherwise if only one has an Alamy “Media Reference”, that one is matched. 

 Otherwise, none are matched. 

What happens if something is matched? Most of the metadata that Alamy stores is downloaded and 

associated with that image in Lightroom: 

This can all be used for searching, and most of it can be changed apart from the “License” and “Status” 

fields. The “Alamy URL” takes you directly to a page at Alamy which shows this picture. 

“Sent Date” and “Alamy Media Ref.” are not fetched from Alamy, they are set by the plug-in when you 

use it to upload image to Alamy. 

Hopefully now you will already have most of your Alamy pictures correctly catalogued in Lightroom! 

Let's assume that some weren't matched because of duplicate filenames. 
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If you check the log that was created, they would be marked up as being in error, and a link is provided 

which takes you what Alamy thinks that picture should be. It's up to you now to find it in Lightroom. The 

easiest way is to use the filename that is shown in the log as the basis for a search. 

Once you have found the correct image, you can do one of two things. Simplest is to add the Alamy 

reference, the six-character code like “A3FM1H”, to your image in Lightroom by entering it in the “Alamy 

Reference” field: 

This gives you an exact match. Alternatively, you could add anything you like to the “Alamy Media 

Ref.” field. The next time you use the “Fetch from Alamy” feature, this picture will be taken as a valid 

match, and the others with the same filename will be ignored. 

What if nothing was matched because there was no matching filename at all? You follow the same 

procedure – use the filename or the image in the log to find out what the picture is and then find it yourself 

– and then set the six-character “Alamy Reference” for the right picture. If no filename can be matched, 

the plug-in takes your word for it that this is the right picture. 

FINDING THE ALAMY METADATA 

Several fields are added to Lightroom's catalog 

to store the specialist Alamy metadata for your 

pictures. These are all visible from the Library 

module, in the “Metadata” panel on the right. 

There are two predefined groups available 

which should help. These can be selected using the 

drop-down list to the left of the Metadata header:  
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The new groups contain these fields: 

Alamy 

Submitted Date Media Reference 

Image Reference Media URL 

Upload Status Licence Type 

Pseudonym Needs Sync 

Essential Keywords Main Keywords 

Is Photo Is Altered 

Is a Cutout (no longer used by Alamy) Has People 

Has Model Release Has Property 

Has Property Release Sales Total 

 

Alamy Plus 

Submitted Date Media Reference 

Image Reference Media URL 

Upload Status Licence Type 

Pseudonym Needs Sync 

IPTC Caption IPTC Date Created 

IPTC Location IPTC City 

IPTC State IPTC Country 

EXIF GPS Essential Keywords 

Main Keywords Is Photo 

Is Altered Is a Cutout 

Has People Has Model Release 

Has Property Has Property Release 

Sales Total  
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UPLOAD TO ALAMY 

This exporter uploads selected images to your Alamy account. Of course, you still need to check for quality 

beforehand, and you can also set any standard (i.e. IPTC or EXIF) metadata you want included with the im-

age. 

The Alamy-specific metadata such as details of the pseudonym, number of people etc. are not sent at this 

stage. This is because the initial upload must be a simple JPEG file, and there is no defined place to store 

this kind of information in a JPEG. Please see the Quick-Start section for a more detailed description of the 

standard process. 

Once you are happy with the quality of your images, select them as you normally would in Lightroom and 

select “File→Export...”. 

ALAMY CONNECTION 

If this is the first time you have used the plugin, you will need to enter your Alamy username – usually an 

email address – and password in the Plugin Manager. Once they are entered, click “Log In”. 

If the username and password have been set before, and you ticked the 'Log in automatically ' box, you 

will be logged in automatically. Either way, the 'Export' button will be disabled until you have logged in, 

and some essential information has been retrieved from Alamy. 
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UPLOAD SETTINGS 

This section allows you to change how the upload process works. 

 DUMMY RUN 

Ticking this will run through the whole export process as normal except that no images are sent to Ala-

my, and no changes are made to the custom fields which store the upload status. 

 SHOW LOG ON COMPLETION 

When an upload is finished, you can choose to automatically view a log of the results. This will show 

each image that was processed and a short description of what happened to it. 

The logs are still created if you un-tick this. They can be found in your Documents folder, in a sub-folder 

called 'Alamy Logs'. 

 KEEP PROCESSED JPEGS 

With this ticked, each JPEG that is created as part of the upload process will be re-imported into your 

Lightroom catalog. It will have the same upload information added to it as the original image, except 

that the Status field will be set to 'Submitted Copy' instead of 'Submitted'. 

 IMPORT JPEGS INTO LIBRARY 

If the JPEGs produced during the upload are to be kept, this tickbox controls whether you want then 

imported into your Lightroom catalog or just left on disk. 

 IN FOLDER 

If you choose to keep the processed JPEG images, they are stored in the folder chosen here, in a sub-

folder named for the Alamy Media Reference. As an example, any images uploaded with the settings 

shown in the screenshot above would be stored in a folder called “E:\AlamyUploaded\OL464723”. 

SCALE TO MEGABYTES 

A custom filter is provided with the plug-in, which must be used. This filter scales each image up so that it 

fulfils Alamy's minimum size requirements, currently that each image must be 24Mb uncompressed. It may 

be safer to scale slightly larger than this, say to 25Mb. 

Any images which are already larger than this size are not reduced unless they are larger than the size given 

as 'Maximum'. 

If this filter is not enabled, the plug-in will refuse to upload anything; the 'Export' button will be disabled. 

FETCH ALAMY METADATA 
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Although this is downloading data from Alamy and updating the Lightroom catalog, it is still used as an ex-

port service, so that all the Alamy-related functions can be found in the same place. Since it is an export 

service, you need to have at least one exportable image selected in Lightroom for the “Export...” menu to 

be available. However, this may work against your entire Lightroom catalog, not just any images you have 

selected, depending on what you ask the plugin to do. 

ALAMY CONNECTION 

This section must be set up exactly as for the 'Upload to Alamy' exporter. 

DOWNLOAD SETTINGS 

This controls how to set any information that is retrieved from Alamy. 

 OVERWRITE IPTC DATA 

When this is not selected, any IPTC fields in Lightroom that have been set already will not be updated 

with metadata downloaded from Alamy. If it is ticked, all matching fields will be set with Alamy's data. 
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 OVERWRITE ALAMY DATA 

When this is not selected, any Alamy-specific fields in Lightroom that have been set already will not be 

updated with metadata downloaded from Alamy. If it is ticked, all matching fields will be set with 

Alamy's data.  

These two controls should allow you to set some of your Alamy metadata during their QC process, 

perform a Fetch operation to get the Alamy Ref, and then upload the completed metadata. 

The “Alamy Ref” and “Image URL” fields are always set during a fetch, regardless of this setting. 

 SHOW LOG ON COMPLETION 

As with the Upload to Alamy export service, this shows a log of the 'Fetch Metadata' operation once it 

has completed. These logs are extremely useful for tracking what has changed, and for correcting any 

problems. 

 FETCH DATA FOR … IMAGES 

Using this you can control how much information is retrieved from Alamy. You can choose between 

'All', 'Not Ready', 'Ready', 'On Sale', 'Selected', and the first 100, 500 or 1000 images, sorted by how 

recently they have been uploaded. 

Retrieving data is fairly quick so normally 'All' is acceptable, but if you have many thousands of images 

for sale with Alamy it might be more efficient to only retrieve metadata for the most recent ones. 

If you choose 'Selected' images, the plugin will try to request data for the specific images you have 

chosen. If the image has already had data downloaded from Alamy, it will have Alamy's unique 

identifier associated with it. If this is not the case then the plugin will fall back on first an “Alamy Ref” 

value, and then to the “Your Ref” value based on the filename, and will search Alamy's database to find 

any potential matches. 

 … KEYWORDS 

For Lightroom 3 or higher, you have the option to update your Lightroom keyword list based on the 

keywords set at Alamy. “Merge” will add Alamy's keywords to any that already exist in Lightroom, while 

“Replace” will also remove any Lightroom keywords that aren't set at Alamy. “Ignore” makes no 

changes at all. See p.19 for (much) more information. 

 PRESERVE LIGHTROOM KEYWORDS 

When keywords are being downloaded to Lightroom 3 or higher, they are usually stored in the 

“Essential” and “Main” keyword fields and then split down to either merge or replace the Lightroom 

keyword assignments, depending on the setting of the previous dropdown. If you tick the “Preserve 

Lightroom Keywords” option then this last stage is not done. 
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 MATCHING : PREFIX 

This setting, and the following ones, affect the way that the plug-in matches Alamy's “Your Reference” 

to your filenames in Lightroom. The simplest case is where the filename has not changed since you 

uploaded the file to Alamy, in which case the filename and “Your Ref” values will match. In this simple 

case, leave all the “Matching” fields empty. If you rename your photos after uploading them as a 

matter of course, you will need to use this part of the dialog to help with the automatic matching 

process. 

There are many possible combinations that you can use here. Please see page 17 for some examples. 

This field gives a prefix which is expected to be at the start of the Alamy “Your Reference”. This prefix, if 

it exists, will be removed before matching. 

 MATCHING : REPLACE … WITH … 

After any prefix has been removed, the plug-in will replace the word in the first box with the one in the 

second. 

 MATCHING : WITH KEYWORD 

For any files that match the “Your Reference”, they will only be matched if they also have the keyword 

in this box. 

 MATCHING : EXAMPLE REF 

This gives an example “Your Reference” to apply the previous rules to. You can find a “Your Reference” 

value by using Alamy's online tools and enter it here to make sure the rules change it in the way that 

you expect. 

 MATCHING: IN COLLECTION 

Only images that are a part of the named collection will be considered for matching. 

 MATCHING: NOT IN COLLECTION 

Images that are part of the named collection will never be considered for matching. This is most useful 

when combined with a Smart Collection which filters on the “Folder” value. 

 MATCHING: WITH VCOPY 

Only Virtual Copies that have this text in their name will be considered for matching. For example, if 

you create virtual copies to submit to Alamy and all your virtual copies contain the phrase “Alamy” in 

their name, by entering “Alamy” in this field you would narrow the matching search to only those 

virtual copies. 
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SAMPLE MATCHING SETTINGS 

Getting the match between your Alamy photos and their original in Lightroom is possibly the trickiest 

part of getting the plugin set up. If you leave the filenames as they were when you submitted them, you 

will have few problems. 

As long as you stick to one method of renaming, or of marking your Lightroom catalog to include or 

exclude photos, some combination of “Matching” settings should work consistently once it has been set up. 

Exactly how you need to set this section will depend on your individual way of marking or renaming 

your photos, but the following tips may help. Each tip is independent of the others. 

- Include all your submitted photos in a standard Collection and use the “In Collection” control to 

limit matching. 

- When you submit a photo, add a non-exportable keyword such as “_Alamy_”, and require this to 

be present using the “With Keyword” option. 

- If you keep the exported JPEG copies, you can exclude these by adding a different keyword and 

requiring this not to be present using the “Not Keyword” option. 

- Always export the JPEG copies to the same folder structure, and use a Smart Collection to list the 

contents of this folder. For example, store them under “C:\Photos\AlamyJPEGs” and set your Smart 

Collection to match this as part of the path. You can then use the “Not In Collection” control to 

exclude these JPEG copies. (Normally they would be excluded anyway, but if the field that identifies 

them to the plugin as exported copies is changed or lost, they would become eligible for matching 

as an original copy). 

- If you have renamed your photos and kept to a consistent renaming scheme, use the “Remove 

Prefix”, “Add Prefix” and “Replace” … “With” boxes to describe how you rename. There are many 

possible combinations of settings for these boxes, and they will be highly individual. 

- In all cases, the easiest way to find out what will happen is to simply read the small description to 

the right of the “Matching” box. 

SCALE TO MEGABYTES FILTER 

This filter, used as part of the “Upload to Alamy” exporter, is completely unused here. However, if it is 

included with the “Upload” exporter as it must be, Lightroom also includes it automatically with both the 

“Fetch Alamy Metadata” and “Set Alamy Metadata” exporters. To save having to remove and re-add it, 

simply ignore it. 
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HOW IT SETS METADATA 

Each image that is downloaded from Alamy will be matched to the Lightroom catalog, based on the 

Alamy “Your Reference” field. This is automatically set by Alamy to the image filename when they are 

uploaded. This means you should use unique filenames so that you can identify the correct images after 

they have been uploaded. 

When the plugin first tries to fetch metadata for a given photo, it needs to use the current filename to 

try to match Alamy’s “Your Reference” field. If you have many images with matching filenames, or none at 

all, the plug-in will look in Lightroom’s “Alamy Ref.” field for each photo and use anything it finds there to 

try and match the reference value returned by Alamy. This allows you to force a match for a specific image 

by manually entering the correct Alamy Ref. 

Next, any keyword you gave in the dialog is searched for in each potentially matched image. Any 

images which don't have this keyword set are ignored. 

Finally, if only one matching filename is found, that file will have all the Alamy metadata fields set. If 

more than one is found, any that have a value in the “Alamy Media Ref.” custom field will have their 

metadata set. 

In short, by far the easiest way to get your photos matched correctly is to use unique filenames for 

them, before they are uploaded to Alamy! 

I use a two- or three-letter code for the subject, followed by a memory-card number, followed by a 

sequence number. For people taking many more photos than I do, you could maybe use a combination of 

date and sequence. This can be set in Lightroom's “Import” dialog, in the “File Naming” section, so that you 

don't even have to rename things yourself. 

If you have many photos with exactly the same filename, the only way to reliably match them against 

Alamy's data is for you to use the logs that are created as part of the Fetch process. In these logs you have a 

link to the appropriate image on Alamy website, along with a thumbnail of the image. This link is also 

stored in the “Alamy URL” field in Lightroom. Using this information, it is up to you to find the right match 

visually, then type in the correct Alamy Reference to the right image in Lightroom. 

Once the photo is matched and you have the “Alamy Ref” field stored, you are free to rename the 

photo in Lightroom if necessary. I would still recommend renaming photos before submitting them, if only 

to save potential confusion later on. 

SETTABLE FIELDS 

The following list of metadata fields can be set with information from Alamy: 



Lightroom Alamy Picture Manager - Manual 

 19  

http://www.lightroom-plugins.com 

 

KEYWORDS 

Keyword handling has changed as of March 2012. Even if you have used the plugin for some time, 

please read this section! 

Lightroom 2 doesn't provide a way for a plugin to affect the normal keywords. This has changed with 

Lightroom 3 and the plugin is now capable of downloading keyword changes from Alamy along with the 

other data. However, setting keywords is more complicated than it might appear because of the 

hierarchical way that Lightroom stores keywords. 

Alamy's own data: 

 Is A Cutout 

 Photograph or Illustration 

 Is Digitally Altered 

 Shows How Many People 

 Has a Model Release 

 Shows Property Requiring a Release 

 Has a Property Release 

 Licence Type 

 Pseudonym 

 Essential Keywords 

 Main Keywords 

 Sales value 

 Description 

IPTC data: 

 Caption 

 Date Taken 
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Most tools assume that keywords are a simple list of words. Lightroom has a much more powerful 

keywording system where a keyword can have parents, children and synonyms. When you add a keyword 

to a photo, all that keyword's parents (a parent can also have parents) are also added. If any keyword has 

synonyms, they get added too – adding one keyword to a photo can result in dozens of other words being 

added along with it. The complexity arises when one of the automatically-added words is changed using 

Alamy's online tools. 

Let's say you have this structure: 

Keyword Synonyms 

Asia travel 

↘Cambodia  

    ↘Siem Reap  

        ↘Angkor Wat temple, ancient, unesco 

 

You add the keyword “Angkor Wat” to a photo. When you export that photo, it will have these 

keywords: 

ancient [Angkor Wat] Asia Cambodia [Siem Reap] temple travel unesco 

Note that the keywords with spaces have been passed in with square brackets around them. This is 

Alamy’s recommended way of keeping multi-word keywords together (see 

http://www.alamy.com/contributor/help/annotation-options.asp) while not restricting the search. Now 

assume that you've used Alamy's online keyword editor to remove the “Asia” keyword. The only keyword 

that was added to the photo in Lightroom was “Angkor Wat”, and removing that would also remove all the 

other keywords that were added automatically. 

Also, if you had previously sent keywords made up of multiple words, there is a good chance that they 

will have been separated into single words by Alamy. If you uploaded the image originally with an older 

version of the plugin, or using Alamy’s online tool, the keywords would have been sent as the following: 

ancient Angkor Asia Cambodia Reap Siem Temple travel unesco 

In this case, the keywords returned no longer match the keywords stored in Lightroom because “Siem 

Reap” and “Ankgor Wat” have been separated. 

The keyword update rules in the plugin will try to work around these situations. It will try to match 

pairs of incoming keywords to single Lightroom keywords with spaces. If multiple keywords are received 

from Alamy that are missing from Lightroom it will try to find existing hierarchies which add as many of the 

http://www.alamy.com/contributor/help/annotation-options.asp
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missing keywords as possible rather than creating new, individual keywords for each one. Lastly, if it has to 

remove a keyword which has parents and/or synonyms then it will recreate as much of the remaining 

parent/child/synonym structure as possible instead of creating single, unrelated keywords. 

Please see page 25 for a separate description of how the keyword fields are filled out by the Set 

Metadata part of the plugin. 

PSEUDONYMS 

Alamy has a feature where one photographer or agency can submit photos under different names. This 

can help you to track your photos. It also maintains a separate AlamyRank value for each pseudonym, 

which may be of use if your various photographic subject areas sell differently. 

You can choose which pseudonym you use for each photo from Lightroom, using the “Pseudonym” 

drop-down list. However, Lightroom wants the contents of all such lists to be pre-defined by the 

programmer. 

To work round this, one of the plug-in's own files – “AddPseudonyms.lua” – is re-written by the 

plug-in itself. Every time you use the “Fetch Alamy Metadata” exporter, your pseudonyms are fetched from 

Alamy. If they don't match the current list, the list is updated. Because Lightroom isn't expecting parts of 

the program to change as it is running, you need to restart Lightroom to pick up these changes but you will 

be reminded of this: 

 

On restarting Lightroom, you will be prompted to update the catalog again:  
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Two backups of the changed file are made. One is in the plug-in folder itself, and the other is in your 

Documents folder. Both will be called e.g. “AddPseudonyms.lua_v6”, where the “_v6” part shows the 

previous version number. 

It is important that you keep these backup copies safe. If you revert to an older version, for example if 

you copy your catalog to a new computer and reinstall the plug-in, Lightroom will refuse to activate the 

plug-in. If this happens, you need to change the version number listed inside the “AddPseudonyms.lua” 

file to be at least equal to the one last used and re-activate the plug-in using Lightroom's “Plug-in Manager” 

dialog. 

SET ALAMY METADATA 

This exporter takes all the metadata for any selected images which have an “Alamy Reference” set, and sets 

the corresponding fields at Alamy. 

ALAMY CONNECTION 

This section must be set up exactly as for the 'Upload to Alamy' exporter (see page 12 for details). 
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METADATA SETTINGS 

This section controls how much information is sent to Alamy. 

 DUMMY RUN 

With this ticked, no information at all is sent to Alamy. You can use this to check that everything is likely to 

be OK when the data is actually sent; mainly it is here as an aid to testing. 

 UPDATE EMPTY FIELDS 

Normally, any metadata fields in your Lightroom catalog which have no contents will not be uploaded to 

Alamy. This allows you to merge your local metadata with theirs. Ticking this box will also send empty 

values, clearing any data that Alamy may be storing for that field. 

 SHOW LOG ON COMPLETION 

As with the Upload to Alamy export service, this shows a log of the “Set Metadata” operation once it has 

completed. The log will show a thumbnail of each photo and a list of items that were sent. 

 UPLOAD IPTC FIELDS 

With this ticked, the IPTC “Caption”, “Location” and “Date and Time” fields are sent to Alamy. 

 UPLOAD KEYWORDS 

With this ticked, lists of keywords are sent to Alamy. Please see page 25 for full details. 

 UPLOAD ALAMY FIELDS 

With this ticked, Alamy-specific metadata such as “Image Type” and “Model Release” are sent to Alamy. 

 POPULATE KEYWORDS … 

Controls how and when keyword fields are changed. Please see page 25 for details. 

SCALE TO MEGABYTES 

As with the “Fetch Alamy Metadata” exporter, this is completely ignored. 

HOW IT SETS METADATA 
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Each image that you have selected in Lightroom is checked to see if it has a valid “Alamy Reference” 

set. If it does, that reference is used to tell Alamy which image to update. Any metadata you have in 

Lightroom is packaged up and sent to Alamy. These are the fields that are sent: 

  

Alamy's own data: 

 Is A Cutout 

 Photograph or Illustration 

 Is Digitally Altered 

 Shows How Many People 

 Has a Model Release 

 Shows Property Requiring a Release 

 Has a Property Release 

 Essential Keywords 

 Main Keywords 

 Pseudonym 

 

EXIF data: 

 Date Taken 

 

IPTC data: 

 Caption 

 Date Taken (if no EXIF data exists. Should be formatted as 'YYYYMMDD'.) 

 Location 

Alamy expect a single 'Location' value, while IPTC provide four. The value sent to 

Alamy is made up from the IPTC 'Location', 'City', 'State' and 'Country' fields. 
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HOW IT SETS KEYWORDS 

Keywords are a special case. Alamy split keywords into three groups – “Essential”, “Main” and 

“Comprehensive”. Normally for photos, keywords are stored in a single group. To try and work round this, 

there are two new metadata fields for Alamy's Essential and Main keyword groups. These are simple text 

boxes, and keywords should be entered with spaces between them. 

According to Alamy’s recommendations, you can enter multi-word keywords such with double-quotes 

round them - e.g. “King Kong” - to have them treated as a single word or with square brackets e.g. [large 

ape] to have them treated as related, but still able to be matched individually. When the plugin is building 

keyword lists, it assumes that any single keywords which have spaces in them are to be sent as related 

words. 

One other unfortunate aspect of Lightroom’s otherwise excellent keywording system is that when a 

plugin requests a list of keywords, they are provided in strictly alphabetical order. This is a problem when 

the order of the keywords is important, as it is for Alamy, and especially for the case described below. 

WHEN YOU HAVE NO ESSENTIAL OR MAIN KEYWORDS 

The plugin maintains separate fields for Alamy’s “Essential” and “Main” keyword lists. These are the 

most significant for searching, and therefore for your AlamyRank. If either of these fields is empty, the 

plugin will use all the assigned keywords for that photo to fill these fields, up to Alamy’s limit of 50 

charaters for “Essential” and 300 characters for “Main”. Although these keywords will probably not be in 

the best possible order, any keywords will be better than none. The exact order in which the keywords are 

added depends on your settings; these are discussed below. 

WHEN YOU DO HAVE ESSENTIAL AND MAIN KEYWORDS 

Since the “Essential” and “Main” keyword fields are maintained separately by the plugin, you are free 

to alter these in any way you like and they will be sent to Alamy untouched. The only time that changes 

would be made to these fields is when they are too long. It is not possible to tell Lightroom to limit a text 

field to a set number of characters, so there is nothing to stop you entering more than the number of 

characters that Alamy will accept. If this happens, you will end up at best with important keywords missing 

and also possibly with partial keywords. 

To avoid this, if the “Essential” field is too long then words will be moved to the start of the “Main” 

field, so as to maintain the order of importance as closely as possible. Similarly, if the “Main” field is too 

long then words will be dropped from the end and sent as the first words of the Comprehensive field. 

KEYWORD ORDERING 

There are several places where you can tell the plugin to assign keywords to a photo, based on the 

Lightroom keywords. When assigning keywords, there are several options which affect how they are 

assigned. Automatically-assigned keywords are never going to be as good as manually-assigned ones, so 

the intention of this feature is simply that having any keywords at all is better than having none. 
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The two main choices are whether or not to merge new keywords with existing ones, and in what 

order. 

MERGE OR REPLACE 

The simplest option is to replace the Alamy “Essential” and “Main” keyword fields entirely.  

If you have already assigned keywords manually but wish to include new words that have been added 

to the Lightroom keyword list, you can choose to merge the new words with the existing ones. 

This works by creating a single list where the Essential keywords are first, then the Main keywords, and 

then all the Lightroom keywords which are not already on the list. This list is then split into the three fields 

in order of importance. In this way, any keywords which you have already manually assigned will retain 

their importance and any new words will be added to the end. 

KEYWORD ORDERING 

There are three options for ordering the keywords before they are assigned to the Alamy keyword lists; 

“Alphabetical”, “Unordered” or “Priority”. 

Alphabetical order is exactly as it sounds; before being assigned, the keywords are sorted. This is similar 

to the order in which Lightroom would normally return keywords anyway, if you don’t use any hierarchy or 

synonyms. 

Unordered applies no sorting at all. Words will be added in the order that Lightroom returns them, 

which is basically alphabetical. However, related words – synonyms or parents – will tend to be grouped 

with the words to which they are related. 

Finally, priority mode applies some basic analysis to the individual words and assigns each one a 

priority, and this priority is used to order the list before it is split. Priority ordering is detailed in the next 

section. 
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UNDERSTANDING PRIORITY ORDERING 

Each keyword is allocated a priority, based on some very simple observations. No real linguistic analysis 

is done, but the results are often considerably better than no ordering or alphabetical ordering. 

The following areas are considered when the priority is calculated: 

- A single keyword made up of more than one word is higher priority. 

- A keyword which is included automatically as a parent of another keyword is lower priority. 

Typically, a hierarchy of keywords will have general areas at the top of the hierarchy and more 

specific terms as you go down. 

- A keyword which is capitalised is higher priority. 

- Synonyms are lower priority. 

- Words which are also used in the caption are higher priority. 

With these simple rules, a good attempt can be made to guess the relative importance of different 

terms. This method does depend, however, on using Lightroom’s keywording system effectively. 

The most important aspect is the use of hierarchy. Lightroom is capable of grouping keywords together 

in tree structures, and assigning a keyword which is part of a group will automatically assign all keywords 

which lie above it in the group. 

For example, in the screenshot to the left there is a keyword hierarchy 

covering geographical names. If you were to add the single keyword “Kom 

Ombo” to a photo, Lightroom would automatically assign the keywords 

“Egypt” and “Africa”. 

When calculating the relative priorities of these keywords, “Kom Ombo” 

would be seen as highest priority, then “Egypt” because it is above “Kom 

Ombo” in the tree structure, and then “Africa” with the least priority. The 

“tourism” keyword has been marked as “Not for export” in Lightroom, so 

would not be considered. 

“Kom Ombo” would also get a small priority increase because it is 

capitalised, and another because it has more than one word. 

If you were to add “tomb” to the same photo, it would be seen as fairly high priority because it is the 

last item in it’s hierarchy – it has no descendants – but since it is not capitalised and is made up of a single 

word, it would be considered as lower priority than “Kom Ombo”. 

In short, grouping your keywords in this way can save you a lot of time when adding keywords to a 

photo because it is possible to add many keywords which have at least some relevance very quickly, by only 

adding a single, very relevant word. By using this powerful and under-appreciated feature of Lightroom, 
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you will also help the plugin to make more intelligent decisions about allocating your keywords in a suitable 

order for Alamy. 

THE PLUGIN EXTRAS MENU 

Several useful tools can be found on the “Plugin Extras” menu, on the Library menu. 

CLEAR ALAMY METADATA 

Sometimes you may need to remove the Alamy-specific metadata from your images, for example if a 

submitted image is rejected or deleted, or if the wrong image is identified during the Fetch process. 

Because some of the metadata fields are read-only, such as the Status field, you can't do this manually. 

There is an option on the Library menu which will do this for you. You can choose to remove only the 

Status value, or all Alamy metadata, from all the images currently selected by using the “Library→Plug-in 

Extras→Clear Alamy Status” menu. 

A small dialog will appear: 

 

This simply gives you the option to cancel and do nothing, or to continue and clear the Status or all 

other Alamy-specific metadata fields such as “Essential Keywords” and “Media Reference”. 

EXPORT TO CSV 

If you need to get the Alamy metadata into another application, this command will help. It creates a 

CSV file (Comma Separated Values) which can be read by many applications including Microsoft Excel. 
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To use this command, select the “Library→Plug-in Extras→Alamy Export to CSV” menu item. You 

can choose one of three different layouts for the CSV file; one is general purpose, one is in a format 

specified by Alamy, and the last is intended as a way to exchange keywords with 3rd-party companies. 

IMPORT FROM CSV 

This allows you to import from a CSV file containing keyword information. If you use another 

application or a keywording service to provide your keywords, this command will help. 

 

To see the correct format for the CSV, simply run the Export to CSV command set to the “Keywords” 

mode. The resulting file will be correctly formatted. 

When reading the file, it requires at least one of the first three fields to be present. These give the full 

path, the filename and the Alamy Reference for the photo. When the import is complete, you can see the 

results in the logfile that is created. As with other commands, the “Dummy Run” option lets you try the 

import without making any changes. 

REASSIGN KEYWORDS 

This will either replace or augment your existing 

Alamy keyword fields, based on the Lightroom 

keywords. For full details of how the automatic 

keywording works, please see p.25 . 
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PREVIEW KEYWORDS 

Similar to the previous command, this works 

out the keywords for the current photo based on 

different keywording settings. Unlike the previous 

command, this one will only show you the 

keywords without changing anything. You can use 

this to see the effect of making changes to the 

Lightroom keyword hierarchy quickly, without 

needing to make any changes or read log files. 

 

 

FIND DUPLICATE ALAMYREFS 

It is possible to end up with more than one photo with the same Alamy Reference value set. This value 

is the most important one when it comes to all fetch and set operations, so this can mean that you make 

unintentional changes to important fields by sending data for one photo more than once. 

Another easy way to have duplicates created is to simply create virtual copies, after the original photo 

has had an Alamy Reference set. 

To help prevent this, running the “Find Duplicates” command will scan your entire catalog to find any 

photos which share the same Alamy Reference. They will show up in one of the supplied Smart Collections, 

and from there you can choose which of the two (or more) photos is the genuine one. You can then use the 

Clear Alamy Metadata command, described on p.28, to clear all Alamy information from the 

inappropriately-labelled images. 
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UPDATE WORD COUNTS 

New in V1.0.3067, the plugin will do some basic analysis of your captions and keywords to try and 

highlight areas which may need attention. Lightroom already gives you the option to show photos which 

have no caption or keywords and there are Smart Collections set up to show these. There is now the ability 

to get more information on these important areas. 

This menu item performs some simple checks on the caption and keywords of any selected photos that 

have Alamy data associated with them. Typically you would select all your Alamy photos and then run the 

command. Unfortunately there is no way to make Lightroom automatically notify a standard plugin when 

keywords or caption change, so for now it is necessary to manually use this menu item to update the 

counts. 

Each field – caption, and the three keyword fields – are analysed. At present this done as a simple count 

of words which are not stop-words. “Stop-words” are those which typically contain little or no information 

of themselves, and are usually ignored by search engines. Words such as “the”, “as”, “to” etc. will be 

ignored by the plugin, leaving only those words which carry descriptive information. The number of 

remaining words in each field is counted and stored. 

After the command has run, you will be able to use the Library module’s Filter Bar to access the results. 

 

The Filter Bar now has access to five new filter fields: 

- Alamy Caption Words 

- Alamy All Keywords Count 

- Alamy Ess. Keywords Count 

- Alamy Main Keywords Count 

- Alamy Comp. Keywords Count 

Changing the filters is done by clicking the name of an existing filter group – that is, if the filter currently 

exists for “Keyword” as in the screenshot above, click on the “Keyword” title and you will get a drop-
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down list from which you can select the new Alamy-specific filters. There is a full tutorial on using the 

filter bar at http://www.learn-to-lightroom.com/articles/library_filters/ . 

Using these new filter options, you can quickly find any photos which have too few words in any of the 

keyword or caption fields. 

 

LOGGING 

Many of the commands will create a log of their actions. This log will be created in a subfolder of your 

Documents folder called “Alamy_Logs” and will consist of one or more html files. If a logfile is created then 

you will be given the option of showing the log automatically once the action completes. 

Old logs are left in place, but you are free to delete them whenever you wish. 

The layout of the logs has been improved in March 2012 and now looks like this: 

 

The left-hand part of the page shows the photo that corresponds to this log entry. These thumbnail 

images are taken directly from Alamy’s website, so you will need to be online for the thumbnails to appear. 

If you are not online you can still use the Alamy Reference, shown above the thumbnail, to identify the 

image inside Lightroom. 

The Alamy Reference as well as the thumbnail are a link which will show Alamy’s page for this photo in 

the right-hand panel of the page. 

The main part of the left-hand panel is a description of what was done for each photo. Every item of 

information that was sent or changed will be listed here, even in “dummy run” mode. 

http://www.learn-to-lightroom.com/articles/library_filters/
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Finally, you can change the number of photos that appear on each page of a log in the Plugin Manager. 

KNOWN PROBLEMS 

DATE CREATED IS SET ON EVERY FETCH 

In Lightroom 3.6 there is a bug where the “Date Created” field is returned to plugins as an empty value. 

This means that it will be set every time you perform a Fetch. This bug has been fixed in Lightroom 4.0 . 

 


